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Copyright Notice

This documentation is the intellectual property of Festo AG & Co. KG, which also has the exclusive copyright. Any
modification of the content, duplication or reprinting of this documentation as well as distribution to third par-
ties can only be made with the express consent of Festo AG & Co. KG.

Festo AG & Co KG reserves the right to make modifications to this document in whole or in part. All brand and
product names are trademarks or registered trademarks of their respective owners.

Legal Notice

Hardware, software, operating systems and drivers may only be used for the applications described and only in
conjunction with components recommended by Festo AG & Co. KG.

Festo AG & Co. KG does not accept any liability for damages arising from the use of any incorrect or incomplete
information contained in this documentation or any information missing therefrom.

Defects resulting from the improper handling of devices and modules are excluded from the warranty.
The data and information specified in this document should not be used for the implementation of safety func-
tions relating to the protection of personnel and machinery.

No liability is accepted for claims for damages arising from a failure or functional defect. In other respects, the
regulations with regard to liability from the terms and conditions of delivery, payment and use of software of
Festo AG & Co. KG, which can be found at www.festo.com and can be supplied on request, shall apply.

All data contained in this document do not represent guaranteed specifications, particularly with regard to func-
tionality, condition or quality, in the legal sense.

The information in this document serves only as basic information for the implementation of a specific, hypo-
thetical application and is in no way intended as a substitute for the operating instructions of the respective
manufacturers and the design and testing of the respective application by the user.

The operating instructions for Festo products can be found at www.festo.com/sp.

Users of this document (application note) must verify that all functions described here also work correctly in the
application. By reading this document and adhering to the specifications contained therein, users are also solely
responsible for their own application.

© (Festo AG & CO. KG, D-73726 Esslingen, 2019)
Internet:  http://www.festo.com
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Hardware/Software

1 Hardware/Software
Typ/Name Version Software/Firmware Production date
CHB-C-N TN : 3501040 3.6.1.0
CHB-C-X TN : 536084
CheckKon 4.3rel 06
Checkopti 3.2rel 06

Table 1.1: Hardware/Software

1.1 Manuals

CHB-C-N manual from support portal www.festo.com/sp.

DE: 8046181
EN: 8046182
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Page 5 of 35



https://www.festo.com/sp

Description of the task

2 Description of the task

The application note should describe the exchange of a checkbox CHB-C-X (TN 536084) with a checkbox of the
current CHB-C-N series. Due to technical innovations there is the necessity to adapt parameters and settings to
the new platform.

Replacement is necessary if the old device can no longer be repaired or a repair is no longer economical.

Furthermore, there are situations in which an installation is to be duplicated and the previous model can no
longer be used. The improved hardware and software allows critical inspections to be improved and performed
more reliably. With 256 test program locations, the new CHB-C-N offers considerably more memory options than
its previous model. This could also justify an exchange

The exchange described here in the Application Note is based on the data of the existing system. Either they can
be backed up from the old device, or they come from a data backup that has been saved previously.

If no more data is available, all basic settings must be carried out again.

The description of a new basic parameter setting is explained out in another Application Note " Application of a
checkbox CHB-C-N on a conveyor belt system". Please use them.

The description of the exchange is intended for people with basic knowledge of the Checkbox and the Checkkon
and Checkopti software package.
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CHB-C-X CHB-C-N
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3 Overview of procedure and sequence

The exchange is divided into several sections, which are listed here:

Data backup old device CHB-C-X (or from backup file)
Disassembly of old unit

Assembly of replacement unit CHB-C-N

Electrical connection CHB-C-N

Configuration CHB-C-N from data backup

Test run and data backup CHB-C-N

When using additional inspection tools from Checkopti:

Adaptation of test program to CHB-C-N from data backup
Test run and data backup CHB-C-N

Optimization of the testing process

Procedure for changed resolution

Overview of procedure and sequence
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Data back-up CHB-C-X

4 Data back-up CHB-C-X

This step is about saving the system parameters and the test programs stored on the device. These system pa-
rameters are used for the configuration of the new device.

Another backup is made when the grey scale line is saved. This documents the "optical/mechanical" mounting
situation.

If the checkbox, to be replaced, can no longer be connected, obtain the necessary data from a stored backup.
The necessary files are: a system parameter file with the file extension xxx.cbs and, if necessary

a Checkopti project file with the file extension xxx.cbp.

If you have the files available with the current status, continue with the procedure in Chapter 5.

Establish a connection to the device with Checkkon. When a connection is made, the existing
system parameters are transferred to the Checkkon.

In the menu View » System Parameters
Example System Parameters:

E System parameter
gl By Eﬂ@| e
B e
----- ! Set Checkbox to default values
----- & Llanguage = CheckKon

-7 Computation time last part

(-8 Check programs

(-8 Operating modes

(-8 Error parameters

£-®g Camera and image

----- & Encoder- to line-frequency ratic = 6

----- & Greylevel threshold = 150

----- & Upper limit of viewing area = 1300 Pixel
----- & Lower limit of viewing area = 200 Pixel
----- ®! Automatic adjustment of viewing area ...
(-8 Advanced image parameters

™8 Cenveying system

B8 Actuators

™8 1/0 cenfiguration

These settings are to be taken over in the new device.

To complete the backup, the test programs stored on the device must be copied to Checkkon.
Open Menu > View » Check program Manager

B Check program Manager X B Check program Manager X
CheckKon: Device: CheekKon: Device:
MName ~ hame A
Buffer - Empty e ——
of Type 1 - Assigned hl
of Type 2 - Assigned < Copy |
of Type 3 - Assigned w
< > < > Copy > |
Fiename | Renare |
Delete > |
Import from file | Import from file |
] - < Delete |
E=port ta file | > Export ta file |

Select all (or those which are used) type memory in the right list and then copy it to the left, using the "Copy" -
button. After copying, the entries are in the left list and in the software Checkkon.

The Check program Manager can then be closed.

Page 8 of 35
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Data back-up CHB-C-X

Saving the grey scale line:

Menu: View » Grey scale line

Press the "Record" button.

Start checkbox, (The display of the checkbox shows "Line") Do not feed any parts!
Stop checkbox.

"Press the "Stop" button in the grey scale line window

Press the red "Save" button

close window

Figure 4.1 example of greyscale line:

%@ Grey scale line EI@
P E @b

Camera ling § Pixel

o 32 84 96 128 160 192 224 256
Camera pixel brightness

Carry out settings and press the Stop button.

Then save the data in the menu: File » Save as...

The backup file has the file extension .cbs

i—lhackup-cbcx.ch:
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Disassembly of the CHB-C-X

5 Disassembly of the CHB-C-X

For safety reason the device must be switched off!
Before dismounting the device, it is recommended to mark the mounting position exactly.
In particular the alignment and height to the conveyor belt.

Mark the connectors of the Actuators and Buffer/Feeder cables!
These 2 connectors could be mixed-up, due to different position on the frontpanel of the new device.

Then remove the front panel connectors in the following order:
Diag, Actuators, Buffer/Feeder, Encoder, PLC, 24VDC, PE.

A Warning

Before loosening the hexagon socket head screws of the dovetail guide, make sure that the check-
box does not slide down and hit mechanically.

Avoid touching or soiling the optical prisms.

Mounting the new Checkbox CHB-C-N

Mount the new device according to the markings you made when removing the checkbox.
Tighten the hexagon socket screws.

Reconnect all connectors in the reverse order of disassembly.
Pay attention to the label on the front panel when connecting.
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Disassembly of the CHB-C-X

Figure 5.1 shows the changed positions of the connections on the front panel.

7l

CHB-C-N
(new)

CHB-C-X
(old)

Buffer/Feeder

Encoder PLC

The earth connection point PE is located on the front panel of the new device. Here it has to be checked whether
the existing length of the PE cable is sufficient. If necessary, the cable must be adapted.
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Parameter setting CHB-C-N from data backup

6 Parameter setting CHB-C-N from data backup

Start Checkkon. (Checkbox is in stop mode)
Establish a connection, now via Ethernet interface, to the device.

Connect in the user level: “modification (password)”, otherwise no adjustments of the parameters are possible.
Password is “mission”

The IP address on delivery is preset to 192.168.2.20 with subnet mask 255.255.0.0.
The current IP address, as well as the firmware version on the device, is also shown in the display.

Figure 6.1 Display after booting.

R e

Make sure that your PC is also set in the range of the IP address and the corresponding subnet mask.
see Windows » Control Panel » Network and Sharing Center

A connectable checkbox is displayed in the search window with a green dot. At a red dot, check the network set-
tings of PC and checkbox, if necessary boot the checkbox.

Figure 6.2 Display in the checkkon after the device search

/ﬁwi ce search ot

The list contains devices of type SBO. .. which were found in your network,
Devices whiche are compatible and connectable are indicated with a green symbal,

|_Mame |
. Pool-System-5HI-2 (192,168, 2,20 / 00-0E-F0-50-B3-7F)

Mew search

Cancel Mexk = |
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Parameter setting CHB-C-N from data backup

Openin Menu » View » System Parameters
In the structure at System, select the function "Set checkbox to default values".

B o e porarnete [E=E=]

B B4t G 5 e2
E1-B18 Systerm

¢! Set Checkbox to default values
& Llanguage = CheckKon
&7 Computation time last part
B8 Check pregrams

"[: Operating modes

G- Error parameters

7-™8 Camera and image

7-™1@ Conveying system

- B8 Actuators

+-™18 170 configuration

CheckKon 4.3 en

Warning !

This command will set all accessable system parameters to their default
values,

If you want to save the current settings to a file or print themn out, press
‘M,

Continue set system parameters to default 7

la Mein

This ensures that all parameters have a valid range of values.

Adjustment of the parameters to the setting of the previous device

Now the parameter settings of the checkbox to be exchanged must be entered in the CHB-C-N. Automatic upload
is not possible due to different technologies.

To set the individual parameters, you should be able to view both parameter structures simultaneously. This
does not require both devices to be connected. Just the new device.

There are 2 ways to do this set-up:

1. Start the Checkkon software in a second task and display the system parameters of the backup file in a
split screen.

Select the option: "no connection, open file only".
Welcome to CheckKon pod

Please select the desired functionality and connection type.

Function:

System ... modification (password) ﬂ

Connection to device:

Connect.. via Bthemet interface ﬂ

via R5232 interface
via modem (remote management)

no connection, open file only

Then open the saved backup file. Customize the view of the windows on your screen so that the
parameter view of both checkons is displayed. » see figure 6.4
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Parameter setting CHB-C-N from data backup

2. Print out the parameters of the Checkbox to be exchanged. » Open the menu View > Systemparamters
and unfold the entire parameter structure with the button as shown.

Figure 6.3

®g Camera and image
B8 Conveying system
Bg Actuators

[1-®g 1/0 configuration

After that select the printer icon in the menu.

u- CheckKon - unnamed
File Edit View Action Mode Mavigate Extra Window Help

EEr OEEECEEEEEEE L
E System parameter

Bl 51 b e | 2

B8 System

& Set Checkbox to default values
-4 Language = CheckKon
-§? Computation time last part
-3 Check programs
... Select check program by = PLC interface
"%l Info: Usable number of check programs
=118 Operating modes
.B Immediate start after power on = no Drucken *
.4 Lock Teach button = off

r~ Drucker
@ Encoder mode = enabled
- @ Good part is "wrongly eriented” as from orientation number = 2 e [USHEEAIERE Fesmnpa ot Vi d MI
E-.I: Counter settings Status Bereit
.4 Counter mode = disabled Typ Canon Generic PCLS Driver

E| 'I: Extended possibility of influencing the part type classification

i Standort:  WBE - Berkheim
. =-™38 Input for external signal

h Kommentar: Eingangsqueue Uniflow i

.. External signal input activated = no [/ Ausgabe i Dalel
1™ PLC test ~ Druckbersich——————————————————— ~ Exemplare

.l PLC test mode = disabled -
8 Error parameters © Hles Anzahl Beemplare: [1 =
E| B8 Error 1: External error " Seten von: r bis I— . i
~ .8 Monitor error 1 = off & Mokionn jjil jilil W Sorteren
'I= Error 2: Optical error 2

@} Monitorerror 2 = on

- B8 Error 5: No feeding parts Hiffe Abbrechen

; i@ Monitor error 5 = off
E|.I: Error &: Part length exceeded
[ RPN TP e
| 4

Now set all parameters of the new Checkbox CHB-C-N in the parameter structure, according to the printout of
the backup file. The value can be changed by double-clicking on the respective parameter. The change is
transferred immediately and is permanently stored in the device. For new parameters and parameters that do
not exist in the old backup, leave the default value.
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Parameter setting CHB-C-N from data backup

Figure 6.4 View of the 2 system paramter windows in a split screen

Fﬁ— I £ CheckKen - Backup_CHE-C-X.chs I
‘ File Edit View Action Mode Mavigate Extra Window Help File Edit View Action Mode MNavigate Extra Window Help
IFHS BENERECEEEE|RL/| Fso |2cHE BNERED DE®E|R %5 ¥
B |E||E”E| [E system parameter El@
B £ By 6] | 2 B 1 By €] 2
=g System ~ =-"3 ~
4! Set Checkbox te default values 4! Set Checkbox to default values
# language = Checkon & language = CheckKon
-7 Computation time last part -7 Computation time last part
=1-™8 Check programs Usable number of part types
: B Select check program by = PLC interface ~i Info: Usable number of part types
i Info: Usable number of check programs B8 Operating modes
=™ Operating modes -4 Immediate start after power on = ne
-4} Immediate start after power on = no [ Lock Teach button = off
-4} Lock Teach button = off WM duty cycle=0
.. Encoder mede = enabled E|"[= Counter settings
.. Good part is "wrongly criented" as frem orientation number = 2 L. Counter mode = disabled
B8 Counter settings E|"[: Extended possibility of influencing the part type classification
- Counter mode = disabled E|'[: Input for external signal
11-™1§ Extended possibility of influencing the part type classification : 5---0[‘. External signal input activated = no
E|"II: Input for external signal E|"II: Operation in centrifugal feeder or bowl feeder
‘D External signal input activated = no ; QB Operation in centrifugal feeder or bowl feeder = no
- B8 PLC test 2 B8 PLE tect
L. PLC test mode = disabled . PLC test mode = disabled
=18 Error pararmeters -8 Inputs
E|"[: Error 1: External error =218 Error parameters
.4 Menitor error 1 = off E|'[: Error 1: External error
=8 Error 2: Optical error : ‘B Menitor error 1 = off
: ‘B Menitor error 2 = on E|"II= Error 2 Optical error
E|"II= Error 5: Mo feeding parts i L4l Monitor error 2 = on
L gl Monitor error 5 = off E| B8 Error 4: System recognizes too many incorrect parts
B8 Error £ Part length exceeded ‘B Manitor errar 4 = off
- Manitor error 6 = off E|"[: Error / Warning 3: No feeding parts
B8 Error 8: Encoder blocked . IMenitor error 3 = off
- Monitor error 8 = on E|'I: Error 12: Operating temperature exceeded
B8 Error 12: Inside temperature ‘B Meniter error 12 = on
- Menitor error 12 = on E|"II= Error 16: Part rate exceeded
A 4 i Lo b e b e LM Errar dizanncicwhen contnor data trancfer artive — off v

Unfold the parameter structure as shown in figure 6.3.

Now set all parameters of the new Checkbox CHB-C-N in the parameter structure, according to the printout of
the backup file. The value can be changed by double-clicking on the respective parameter. The change is

transferred immediately and is permanently stored in the device. For new parameters and parameters that do
not exist in the old backup, leave the default value.

A Important change!

One parameter requires special attention. This affects the vertical resolution. In the new device, the
CHB-C-N, a considerable improvement in image quality has been achieved. This causes, that the
default vertical resolution raised to 2048 pixels. In many existing applications, however, the CHB-C-X
works in the resolution of 512 pixels. The difference can be seen in the "size" (height) of the parts in

the picture. Small structures in the contour are displayed better and more detailed at a higher
resolution.

If the parameter,,Resolution reduction: number of grouped pixel=1“ (see figure 6.5) then you can skip the
following description and continue with the next passage horizontal resolution.
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Parameter setting CHB-C-N from data backup

Figure 6.5 Comparison of system

parameters vertical resolution:

CHB-C-X CHB-C-N
E System paran{}er % System parameter [
B3] B By |5 | 2 B B4 B €5 | e
B System [=-™g System
|_=_|"E= Camera and image “ £-®® Camera and image (

----- .

@ Lighting / image generation = backlighting
i@ Attenuation of camera sensitivity = 100
.. Greylevel thresheld = 150

- @ Upper limit of viewing area = 1836 Pixel

& Lower limit of viewing area = 935 Pixel

Y

! Automatic adjustment of viewing area ...
Advanced image parameters

&
- Gain=3
- @ Greylevel threshold = 150

=18 Advanced image parameters
B8 Vertical (height)

Encoder- to line-frequency ratic = &

- Upper limit of viewing area = 1937 Pixel
- @ Lower limit of viewing area = 115 Pixel
Automatic adjustment of viewing area ...

B8 Vertical (height)

i@ Ignore part areas with a height less than = 2 Pixel

& Ignore hole areas with 3 height less than = 2 Pixel
= =

# Resolution reduction: number of grouped pixel = 1

Ignore part areas with a height less than = 2 Pixel

B8 Horizontal (length)
"II: Camera trigger
-3 Conveying system

-8 Actuators

- ™8 110 configuration

Define viewing areas to be ignored
B8 Horizontal (length)
B8 Camera trigger

1 ™18 Conveying system
B8 Actuators

For Help, press F1 System file openec

If a value other than 1 was set, it must be decided whether the new resolution or the previous (possibly smaller)
resolution is to be used.

Generally no clear recommendation for a choice can be given here, however there are following arguments for a
decision.

Advantage higher resolution: More details for small contour differences, e.g. threads or grooves, thus more
stable evaluation.

Previous "critical" inspections may be better and more stable.
No longer processing times!

Disadvantage: All existing check programs have to be reviewed and adapted with a little more effort, especially
for inspections with narrow tolerance values.

Advantage of previous resolution: All images and sizes are retained. The user remains with the "familiar" image
that he already knows.

Here too, check programs must be adapted, but fixed settings and tolerance limits can be adopted as far as
possible.

If many check programs and many types are used, the check programs can be adapted more quickly and with
slightly less effort.

Disadvantage: You do without a more detailed resolution of the parts. Inspections may not be set to their
highest accuracy.

In critical inspections, with small contour differences, stability and liability is not improved.
The following table shows a comparison of the parameter settings:
CHB-C-N

Device CHB-C-X

Resolution vertical 512 Pix Resolution reduction: number of grouped pixel =4 Resolution 512(516)

Resolution vertical 1024 Pix | Resolution reduction: number of grouped pixel =2 Resolution 1024(1032)

Resolution vertical 2048 Pix | Resolution reduction: number of grouped pixel =1 Resolution 2048(2064)

Now adjust the parameter in "Camera and Image" » "Advanced image parameters” » Vertical (Height).
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Parameter setting CHB-C-N from data backup

Horizontal resolution

In addition to the vertical resolution, the checkbox also has the horizontal resolution. The horizontal resolution
determines the number of lines recorded from the part.

In time-controlled systems, this is determined by the parameter "Exposure time in psec". (CHB-C-X). With the
new generation CHB-C-N this is the “Line rate” in Hz.

The value in psec must be converted into the line rate. This is simply achieved by the inverse value. e.g.
1/512psec = 1953Hz. This value must be entered as the parameter value. The setting is made at certain steps.
Take the value closest to the calculated value. The image of the parts (length) then corresponds to the old
system.

Figure 6.6 Horizontal resolution time controlled.

CHB-C-X CHB-C-N
E}y:tem parameter E Systemn parameter
= AT Be| B By 5|
- System

@ Linerate= 2000 H
Ly Gain=3

% Greylevel threshold = 128

& Upperlimit of viewing area = 1967 Pixel
% Lower limit of viewing area = 218 Pixel
®! Automatic adjustment of viewing area ...
Bg Advanced image parameters

ing /image generation = backlghting
- Attenuation of camera sensitivity
@ Greylevel thresheld = 150

- [# Upper limit of viewing area = 466 Pixel

@ Lower limit of viewing area = 74 Pixel
-8 Define viewing areas to be ignered

B8 Advanced image parameters

In encoder-controlled systems the parameter ,,Encoder to line-frequency ratio” stays the same.
Here you can just take the previous value.
(see figure 6.5)

It may also make sense to increase the horizontal resolution. This allows smaller details to be displayed and
evaluated better, e.g. the width of a groove.

The new checkbox offers significantly more memory for a longer scan length!direction!

The effect on the test program also applies if the horizontal resolution changes. The consideration for or against
a change is already mentioned at the beginning of this section. Chapter 9 contains notes on adapting the test
program when the resolution is changed.

Verification of settings

If you change the vertical resolution with respect to the "old system”, the field of view limits must be
readjusted. Even if the resolution remains the same, it is possible that the field of view limits may have to be
“fine" adjusted due to the tolerance during installation of the new device.

For more information on changing the resolution, see chapter 9.

The field of view is displayed and set in the gray scale line window. As described in chapter 4, start the recording
of the gray scale line. The lower area, above the conveyor belt must be observed. The blue line, as the lower
field of view boundary, should have the same distance as it was previously given with the old device.

If the old setting is not available, the lower limit is set as close as possible to the dark area (bottom) of the
conveyor belt. A certain distance is necessary because certain belt movements or dirt particles on the conveyor
belt should not lead to the image trigger. If necessary, use the example in chapter 4, figure 4.1.

The upper limit of the field of view must be above the maximum part height. Especially if the resolution has been
changed, the upper limit (green line) must be shifted in the direction of the largest pixel value. However, it must
remain in the illuminated bright area. Refer to the example in chapter 4, figure 4.1.

The borders of the field of view can be changed by moving the square ends of the corresponding lines with the
mouse. Or doubleclick on the square and enter the figures.
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Parameter setting CHB-C-N from data backup

|| S e s e
192 : . .
128 e ] T S ——————— E———— @1171
“ T S | | i A

0 32 64 56 128 160 182 224 256
e el Allindend

The new value is displayed in brackets but has not yet been transferred.

To activate the new value, the checkbox must be in Stop mode and the recording mode must be stopped as well!
Then the new value can be activated and saved at the same time with the " Accept settings" button.

[

Grey scale line

3 @ be ' &

2048

1584
Stﬂp 15210

Record 1856

After all parameters have been adjusted, it is recommended to save the status.
Select in the menu: File "Save as..." and assign a new name for the data of the new device.

Testrun

Start the checkbox and feed parts. All parts should be discharged at the position for bad parts.

The parts recorded in the "Part contour" window should correspond to the images of the CHB-C-X parts. (At the
same resolution, the same length and height). Compare this based on your stored data. To do this, you can open
backup files by double-clicking and viewing them in the Part Contour window.

If you do not use individual check programs, but work with the default check program of the checkbox, you can
now carry out the "Teach" process.

This works in the same way as you know it from the "old device".
Information on teaching in the parts can be found in the user manual for the checkbox CHB-C-N.
(pn 8046182)

This completes the hardware exchange. After the "Teach process" has been made, the conversion is completed.
(if no Checkopti tools were used in the check program.)

i Information
The following chapters could be ignored

The next chapter describes the adaptation of existing check programs of the CHB-C-X to the new properties of
the CB-C-N. This affects all settings of the Checkopti software.
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Adaption of the check programs for CHB-C-N

7 Adaption of the check programs for CHB-C-N

Since the calculation of tools and features in the CHB-C-N has been changed to another technology, automatic
conversion of the check programs is not possible.

In the new technology, the flexibility of positioning and the relationship of the tools to each other has been con-
siderably expanded. It is now referenced by coordinates, as it is usual with matrix camera systems. Furthermore,
the type and number of tools and features have been greatly increased.

It is possible to "recreate" all previous check programs and it is also possible to install other and previously not
realizable checks.

If you have any further questions about the implementation of your Checkopti project, please contact the

Festo Service.

Use the version: Checkopti V3.2 rel06 for the implementation of the check programs.

The following example shows the implementation of the tools ROl and Ctool. This represents the
most common applications. Other tools can be used according to this method. The Vstrip tool is no longer avail-
able in the new software. This can be replaced by the ROI tool.

In the following description, a project is converted in which the resolution does not change in any direction. I.e.
the images of the CHB-C-X correspond to those of the CHB-C-N. Even if the resolution has been changed, follow
the procedure first. Chapter 9 of this description contains additional information on application with changed
resolution.

The basic innovation is the referencing, therefore the positioning of a tool, at the part. In the previous software,
all referencing options were fix and limited implemented in each tool.

Now it is possible to use all coordinates for referencing also from other tools in the check program.

In the manual for Checkopti (CheckOpti.pdf) this method is described in chapter 8.

This application note cannot show all the possibilities of Checkopti. Here a frequently used application is de-
scribed. The task is a position orientation which is secured with an additional ROI. And we check the
quality/presence of a collar with a Ctool.

Example:

=Y 22 T 1o 1251 T 250 500 750 1000 1250 1500

The position orientation is done by 2*ROI. These are placed symmetrically at the front and rear of the part. In
each position one ROl is “filled” the other ROl is “empty” So the position is clearly defined.

The presence of the collar in the middle is checked by the Ctool. If the collar is missing, the Ctool creates differ-
ent values.

Procedure
Open the existing Checkopti project with the CHB-C-X check programs. (Project X) Save this file with a new
name. This file will be the basis of the new settings for the CHB-C-N.(Project N)

Open the original file again in a second task (Project X). This allows you to switch between the 2 projects at any
time to compare settings.

To simplify the description and to keep the text short, the terms Project X and Project N are used in the follow-

ing explanations.
Pay attention to the bold printed designations Project X or N. Always work in the indicated project.
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Project N: Open the project properties > menu: View > Project Properties to enter the new target device type.
Select the appropriate setting in the fields. See figure 7.1

Alternatively, if you are connected to the device, you can also perform automatic identification by Ethernet inter-
face.(Checkkon must no longer be connected)

Figure 7.1 Figure 7.2
Target device type ttype of device to be simulated):

Automatic identification RS232 interface |
of target device type at...

Ethemet interface |

Device type: |CHB-C-N {Compact Net) -
Firmware version |Currfig V36 -
——————

Firmware Add-Ins: none

Adjust project for new project properties

Max. number of orientations {1..8): 3 The following data will be changed for the required adjustment:
Mz number of tools: 256
1. Check program "Pruefprogramm 1

- Tool _F!OI ie not compatible, will be deleted.
W Insert device properties into projectdescription Tool{s) have to be adjusted 'ROI 1", TTOOL', 'ROI 2

- Tool 'ROI 1" is not compatible, will be deleted.

Project settings: - Tool 'ROI 2" ie not compatible, will be deleted.
= - Tool TTOOL is not compatible, will be deleted.
B
W Project with orientation separation {prefemed orientation)
[T Delete orientations without sample parts automatically
E
E
-
These changes are not supported by the "Undo’ function. Additionally all

r changes done previoushy wont be available arymore!
- Continue with the adjustmert?

—y oK | OK | Cancel

Confirm with OK » then the modification message appears as shown above.(Figure 7.2)
The "old" tools are no longer compatible and were deleted.

A default test program with the same features as in Project X is created, but without the additional tools. The
order of the tools has changed, but this does not matter.

Part contour - Check program 1 EI@
B Ve T B3
By & % | o Bow k@G A S0 R
i i ' i i i # | Sample part results
LR -0 SRR s Ao doemmeoee b b Onentation 1
: : H : : : Scatter c:0
Record no
Recorded on 05.04.2018 15:17:13
B B TR - TR . Contour data size 3050
Info | Tool | Featurs
1250 L--mmmmmm e EEEEEEEEE FEEEEEEEE b Lkt @1 RaI X coord. left
m 2 Y coord. top
m 3 ¥ coord. right
H H H H H H T:= Length x
Ty M
H H H H H H Ts Height y
Ts Arez :
T ¥ coord. center of gravity 744 43 [Piel]
T: Y coord. center of gravity 418.23 [Pixel]
Ts Inertia x 8.16420e=010
T 10 Inertia ¥ 5.12065e+005
T 11. Circumference 4 .00 [Pixel]
T 12 Area w2 2.513842+005 [Pixel]
T 12 Area yi2 2.717832+005 [Pixel]
T 14 Pol. min. distance 3
T 15 Pol. max. distance
< > < >
H:-46 V21805 Sample part 1 Orientation 1 Information:
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Project X: Select in the menu: View the part contour window. Select the first additional tool ROl at pos. 13.
Double-click on the tool name to open the tool properties.

Figure 7.3 Projekt X

& Part contour B2 =R 5 |E’:: e ==EE=E]
C4CT M 0 B xE e gags A48 |4, p.12R00 Ry
: : : : : ; [ Semple part resus
Oremtation P bfo | Function Postion | Vet. suspension |
: : : : : : Scaiter ] o
fooay- ! ; ! ; ; v Record na. p: Size and postion defines a region which is used for the calculation of
Recordsd on 06.04.2018 08:20:07 Ihe tool. A relative postion according to the contoLr, might be helpful
Contour data sza 3082 for compensating variations between the part contours.
Info_| Tool | Feature | Value | Scatter | Wickh: 160 Pixel (absolt) v
T1 Lengih_x 1539 1425 Height 100 Fixel (sbsolt) ~
T: Height
3 A )
;; ;:m Horz. postion [20 Pl (absolt) -
T5 Hrea/Z Horiz.reference:  [absolute from left (part beginn /x=0) ||
T Hreay/2
L CG_co_x Vetical postion: |0 Pieel {absaldt) -
T: CG_coy
T: Polmin Veriical reference: [relativ to maximum of ver. suspension fy) v |
T® Pol max
T Feat_11 fThe alignmet o the shape can be tited using an angle
T2 Feat_12
T2 RO Areainparslel
Ti¢ ROIZ  Areainpanlel Aigment. 0 In degres to horzontal
T 15 Clool1 Heightdffersn... 46.00
250 500 750 1000 1250 1500 v
< >
K1681Y:59 Sample part 2 Crientation 2 Information: Took ROIT

Note the setting of the size (width/height) and horizontal position settings. (tab: Position)
This is required in the next step.

9 Notice

The values (reference) in pixels refer to the upper left corner of the ROI.

When transferring to project N, it must be noted that the reference of the values is now in the center
of the tool. This means that if the values are copied, the value must be changed by this difference
(offset).

See example in the next step.

[llustration of changed tool reference:

' ' ' N N
' ' ' M '
...... L D
' '
' '
' '
' '
' '
' '
------ ) - - - - -.-
L]
reference point ‘
CHB-C-X .
...... ™9 V]| x-offset correction
: '
# J
' D
______ " ) | y-offset correction
' : '
' ‘ .
' '
. L
o s
reference point =) 4 .
CHB-C-N ' —
'

Application Note — Instructions for exchanging a checkbox CHB-C-X with CHB-C-N —1.10 Page 21 of 35



Adaption of the check programs for CHB-C-N

(ke

Project N: Add a new ROI to the check program. This can be done via the icon or

in the menu: Action » Add tool » ROI

The ROl is placed and entered in the tool list. The default position is at the beginning of the part and on the top
contour.

Figure 7.4 part contour window Project N

= [[= | @ |[ 58| | B Tool properties - part xyz new 30.07.18/ B. Smith [ = ]
CEB @B R0 KE 4| 4, b 16 R00 MR-
= = Ex & L )
B R X i 'i L] “.“ L4 : % n\‘* o Sk o | Function [Fostion | Retaton |
; : ; ; : T~ [Sample part rests
Orentation 2 o
omtier N [The size and pesition of the tadl defines @ region where s features are calculated, This way
Record - the tool can be adjusted e .g. according to the size and position of a part in the image.
lecord no. 4
Recorded an 05042012 15:12:30
Contourdsta size 3082
Info_[ Tool Feature
®1 ROl X coord. left bem
®2 ¥ cacrd. top i [ebeol - :
®: X coerd. right
T: Length x Height:
Ts Height y [100 [zbsolute 2
Ts ez
T~ X coord, center of grawiy
T: Y coord. center of gravity
Ts Inzrtia % X coordinate center point: N
T Inertia y 00
’ 0 + [1.RoIX coord. Iet =[x
T Circumference ‘ [ =Ll
T2 res x/2 Y coordinate center poirt:
T Areay/2 = >
v - [2R01Y coord. top -] <[
T 14 Fol. min, distence 21212 [Fiel ; ! ] gl
Tis Pol. max. distance 815.81 [Pl
T 16 ROl Area 13392.00 Foeld :
250 500 750 1000 1250 1500 v
< ¥ < >
%25 Vi1 Sample part 4 Orientation 2 Infarmation: Tool: ROI 1

Double-click on the tool name ROI to open the tool properties.
Skip to the "Position" tab.

a.) Now take the values for width and height from project X. Width = 160 Height=100

b.) The value for the horizontal position (20 pixels from the left / absolute from the left ( part begin x=0) no
longer exists and must be calculated/adapted to the value "X coordinate center point".

The "1.ROI X Coord. Left" (Project N) describes that the positioning (reference) of the tool is calculated from the
left side.

Explanation of the adaption:

20 pixels from the left are converted to X coordinate center = 100.

Explanation: the center of the tool is 80 pixels (0.5*Width160 = 80Pix) further to the right as in the old reference.
In order for the left outer edge of the ROl to begin as before 20 pixels from the beginning, the offset must be
added to the middle. 20+80=100.

¢.) The value of the vertical position "Relative to maximum vert. suspension "Y" is also available in the new
system with Y coordinate Center. The "2.ROI'Y Coord. top" describes that the positioning (reference) of the tool
is calculated from the top, the highest contour pixel.

Here too, it requires a conversion from the old reference upper left corner of the ROl to the center point.

Zero becomes minus 50.

Explanation: the center of the ROl is 50 pixels lower than the upper edge (0.5* height 100 = 50 pixels.).
To ensure that the upper edge is aligned with the upper contour, the center of the ROl must be reduced by 50
pixels. Down, means for the Y-coordinate a subtraction. 0 -50 = (-50).

Positioning the 2nd ROI

Project X: Select the second additional tool ROI2 at position 14.
Double-click on the tool name to open the tool properties. See figure 7.5

In general, the ROl is placed symmetrically at the part in a position orientation. This means that the values for
size and position are identical to the first ROI. Only the horizontal reference changes from absolute from left
(part begin) to absolute from right (part end). Any variations in part length therefore have less influence on the
positioning of the ROI.
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Figure 7.5 part tool properties window Project X

& [s[=][=]
| 4, b 12R02 B e %

Info IFunctlon Position "u"en.suspenslunw

Irfo:

Size and position defines a region which is used for the calculation of
the tool. A relative position according to the contour, might be helpful
for compensating variations between the part contours.

Width: [160 [Pcel tabsolut) 3
Height: [00 [Fixel absolu) ~|
Horiz. posttion 20 [Pixsi @soit) ~|

IHDriz refierence: |ahsnlute from right { part end ) j I
Vertical position: |3 |Pixe| {absolut)

L L

Vertical reference: |re|a1iv to maximum of vert. suspension fy)

[The alignment of the shape can be tited using an angle.

Alignmert: 0 in degree to horizontal

Toolk ROI 2

Projekt N: Add a new ROI to the check program. This can be done via the icon a or

in the menu: Action » Add tool » ROI

The ROl is placed and entered in the tool list. The default position is at the beginning of the part and on the top
contour.

a)Now apply the values for width and height as done in the first ROI.

&= |'= | @ |[ &2 | || ES Tool properties - part xyz new 30.07.18 / B. Smith =
prop: part xyz
G EX e RE W | 4 b [17.R0I2 BELR A
£y = | o &5 Ly )
By B % : 'i " W!. : % n\‘* o R Ifo | Function [Fostien ] Rotation |
' ' ' | | | A | Sample part results
1780} - = mmme - A N N S [ - Orientation z Info:
H H H ' i 1 omtier o The size and pesition of the toel defines a region where fts features are calculated, This way
N the tool can be adusted e.g. according o the size and postion df 2 partin the image
Record no. 4
Recorded an 05042012 1512:30
B I Contour data size 3082
Info_[ Tool Feature |
¥ ooord s ikl
¥ coord. top [160 [absolute |
X coord. ight
Lengthx Height
Height y oo [bsohite |
Area
X coord. certer of gravity
Y caord. certer of gravity b
Inertio x X coordinate certer point. )
Inertiz y [ioo + [1.ROIX coord. left kN
Circunterence e
resx/? 5 P ¥ coordinats certerpol Tty L
Areay/2 275248¢-005 [Pirel] [T 5 01X coordicht : L
Pol. min. distance 212,18 [Pixel] 7. ROIX coord. center of gravty
: Pl max. distance 81581 [P e
: Ares 2 ROFY coord. top
: n 3 RDIX coerd. ight
; (s 4. ROI-Length x
5, A0l Heigty
250 00 750 1000 1250 1500 ~ 6. ROI-Area
< > |« > 7. ROIX coord. canter of gravity
_ ————————————12 ROIY coord. center of gravity
X:1541 ¥:1277 Sample part 4 Orientation 2 Information: Tosl: ROI2 5. ROl Inertia x
10. ROlHnertia y
11. ROl Circunferenics
12 FOlArea%/2
13. ROl Area /2
14, QI Pal, mn, distance
15. ROIPal max, distance
16 A0l 1:Ares

b.) Copy also the values "X coordinate center" of the converted reference position from the ROI 1. The only dif-
ference is that the reference "1.ROI:X Coord. left" is changed to the reference "3.ROI:X Coord. right". This is
done by selecting from the drop down menu at the input field.

9 Note

If the reference is changed, Checkopti calculates automatically a new offset value. This value is cal-
culated in a way that the tool remains at the current position. To move the ROI to the right side of the
part, the original value, in this case 100, must be entered again. Since the offset is added to the co-
ordinate, the value must have a negative sign. This ensures that the ROl is symmetrical position
compared with the first ROI 1.

The "Y-coordinate center" is equal to the values for ROI 1. See figure 7.6
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[B] Part contour - partxyz new 30.07.12 / B. Smith ]l S| B oo properties - part xyz new 30.07.12/ B. Smit [= ===
“w 4% b E Y o @ 4| 4. 17.ROIZ v BB W )
= = | s P -
B 3 % : oG N.«I. : @ n\‘* A f e ]Funcﬁonﬂmaﬁon}
: : : : : T [ Sample pat resuts
: : ; ; : Orentation 2 Info
Scatter e The size and postion of the tool defines = region where fs festures ar= calculsted. This way
ot cie e tool e be adiusted & 0. sGoording to the sizs snd postion of = part in the mags
ecord no. 4
Recorded on 042018 15:18:30
Comfourdata sz 2082
Info_[ Tool Feature [
\
@1 ROI ¥ coord, Ief idih
@2 ¥ coord. top [1e0 [absolute -l
3 Koo fght
T+ Length x Height:
; : :Z':W ¥ [fo0 [sbolute -]
T7 X coord. center of gravity
T: Y coord. center of gravty
Ts Inertia x X coordinate center point.
T 10 Inetia y 100 . 5
[0 3. ROIX coord. ight -] «[i
T Crounference Fioo ‘ El
5 P coordinate center point:
T2 Area /2 ¥ coord
T2 Preayi2 27924364005 G .
2 RO coord.top <] i
T Pol_min distance 21218 [Pissl] ‘ ‘ =l
T s Pol. max. distance 215,81 Picel]
5 _EQ Ao 1238200 [Paceld
< > < >
X550 ;890 Ssmple part4 | Orientstion 2 Information: Took ROI 2

Alternative method without calculation of reference coordinates:

Project X: Place the mouse pointer on the upper left corner of the ROI. Memorize the coordinates x,y for that
point.

Sample part 2 Crientation

Project N: Add an ROI as described above. Set the width and height according to the settings in project X. Now
move the ROl in the image with the mouse, until the upper left corner of the ROl is at the same position on the
part.

Even if the positioning is not "pixel"-exact, this should be sufficiently exact, for the recognition of the position
orientation!

The 2nd ROI can be inserted in the same way. Width and height are taken from project X. Then the horizontal
reference is selected at "X-coordinate center" on “3.ROI:X Coord. Right”.

Now move the ROl in the image with the mouse until it is in the right place at the part as in project X.

Copying tools
If you are familiar with the procedure, you can simplify the process even further.

When you select a tool, you can use the right mouse button to execute the command "Copy tool". This copies
the selected tool exactly. Now only the horizontal reference has to be adjusted with offset.
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Assigning the Ctool tool
A CTool is used to check the Contour in a specific area. This is often used to check the presence of a collar or
thread. In this example, this is the collar in the middle of the part.

(=]

In this example, the tool determines the height difference in a defined section of the contour. If the collar is
missing, then the height difference is different from the sample parts. This could be evaluated.

Project X: Select the CTool1 at pos 15. Double-click on the tool name to open the tool properties. See figure 7.7
Figure 7.7

B Tool properties |?||E”?l £ Tool properties EIIEI
“4a | 4, |1E. CTool 1 ﬂ 2= . | 4, |1E. CTool 1 ﬂ B .
Infa Pos'rtion] Infa ] Function [; Postion |
. Info:
Name: |CT°°| 1 [The section of the part which is defined by “start” and “"end” will be
used for the calculation of the feature.
Feature: {* Height difference { Max. - Min. ) #
" Maximum value
i Mean value Start in row:
€ Minimum value Horiz. position: 520
™ Angle of fitted line
Horiz. reference: |absolute from left { part beginn /x =0 ﬂ
{” Scalar length
End in row:
m Horiz. position: ||223
Horiz. reference: |absolute from left { part beginn /x=10) j
Calculate out of: |Top transition h j l—
Tool: CTool 1 Tool: CTool 1

Memorize the settings in the "Function" and "Position" tab.

2 (@)
Projekt N: Add a new CTool to the test program. This can be done via the icon in the tool bar bl
or in the menu: Action » Add tool » CTool

Fiigen sie dem Priifprogram ein neues CTool zu. Das geht liber das Icon in der Werkzeugliste oder im Menu: Vor-
gdnge » Werkzeug hinzufiigen » CTool

The CTool is inserted and entered in the tool list. The default position is at the beginning of the part on the top
contour.

Double-click on the tool name to open the tool properties. Apply the settings from Project X in the "Function"
tab.
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Figure 7.8 Project N

B Tool properties - part xyz new 30.07.12 / B. Smith =N R
| 4, b [relmoo B x s )
Info IFunctmn IPasnion} Rotation |
Name: [CTeol
Shape S

Features: Feature name
| 7] Height differenice { Max. - i )
[ coord. minimum value
Y coord. minimum value
O coord. mean valus
[ coord. maximum value
Y coord. maximum value
[ Angle of fitted line:
] Sealar length

Caleuiatefrom: | [T transtion |

Search drsction: | [From top El

Took CTool

The settings in the Position tab of the CTool have changed.

First, the width must be calculated:

From project X (see figure 7.7) the beginning and the end of the section is given. The width results from the
difference: 880 pixels - 620 pixels = 260 pixels width. See figure 7.9

There was no height in the X Project. The tool was calculated over the entire vertical image field.
It must therefore be ensured in the new project that the upper contour edge is always sensed by the tool. For
this purpose, the height is set to the entire sensor resolution. (See Chapter 6 upper limit of viewing area)

Since the tool is positioned in the CTool via the X/Y coordinate center (Project N), the coordinates need offset
values.

In the example, a resolution of 2048 pixels is used. The height of the CTool is 2048 pixels.

Since the "Y coordinate center" is in the center of the tool, half of the height is defined as the offset value

so enter.» 2048 :2 = 1024 as Y-coordinate center.

There are no "reference” feature for this setting, so the absolute reference is selected from the drop-down list.
(see figure 7.9 b.)

Enter an offset value for the "X coordinate center" which is exactly in the center of the tool area. So you calcu-
late from left side: 620 pixels +(260/2) = 750 pixels.
(see figure 7.9 a.)

Figure 7.9 Project N

B Tool properties - part xyz new 30.07.18 / B. Smith =0 ISR =
61 | 4, b, 18 CTool ||By 2 ox B!

Info | Function Postion IRotationl

lInfo
The size and postion of the tool defines 3 region whers i festurss are calculsted. This way
the tool can be adjusted e.g. according to the size and posttion of a part in the image.

Width:

250 [absolute 1
Height

[2028 [absolte |

X coordinate center point:

[750 - [1 A0 coord. et B3| B3
Y coordinate center point:

[1024 [absolute |

Tool: CTool
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Now 3 tools in total have been implemented. We recommend to name and save the new check program.

Name a program: Select the "Check program properties " icon:

@c| ‘:TCICheck program 1 j&__} Ec 1 g

il pa contour - Check program
ﬁpl«P‘P%'pm@%|!{%%&.'”—J—l ﬁa@|!ﬂ
BEXEYF o |RAHOOK[AKRE2 S|& I

%= CheckOpti - Beispiel_CHB-C-N_EM.sbp™ Check prl:[}[am properties s
File Edit View Device Action Wizards Navigate Bxtra Window Help Name of check program:
FEOPLEETI-l=11=1= ERRCIN rrmerames

| | : ' ' : ' : A | Sample pe

Then a dialog box opens: Enter a "appropriate" file name. Ideally with date and creators name.

7.1 Completion and Finishing

Connect Checkopti Project N with the checkbox.
In the menu Device there is the function "connect or disconnect from device”.

%= ChnI:’EgOpti - Beispiel_CHB-C-M_EM.sbp®
File Edit View | Device | Action Wizards Mavigate Extra Window Help

BEH vl FERNEERFEE EO|

2| 4. b [oartxyznevfpooriaip smin  ~| B2 B ¥

Connection parameter X

Please set the connection parameters
according to the settings of the device or start a search.
In case of doubt get in contact with your network administrator,

Connection parameter

IP address of device:

Pool-System-SHI (192, 168,2,20 / 00-0E-F0-43-45-DB) |

By the menu ,,View* you can open the "Check Program Manager" to transfer the data to device. Or use the Icon

to open.

&7 CheckOpti - Beispiel_CHB-C-MN_EM.sbp™

File Edit-‘u’iew Device Action Wizards Mavigate Extra  Window Help

a=EE Project properties Alt+] E ():| | - | N2
B 4 b parthis Al P —

Part contour Alt+K

Teach-Data Alt+T

Tool properties Alt+5

Feature graph Alt+G

Data cutput Alt+D

Project decumentation Alt+0

Check program manager Alt+M
Communicaticn manager Alt+C
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In the "Checkopti" and "Device" columns, use the mouse to select the check program and program location.
If source and destination is selected the “Copy to device” button become active and the check program could be
transferred.

Check program Manager =
The lists contain the check programs of the CheckOpti project and of the device. You can transfer and manage the Checdk programs here.
CheckOpti: Device:
MNew MName Mame ~
part xyz new 30.07.18 fB. Smith , 5KB
Copy < Connect = | et = ¥
3. Check program 1, 2091 Byies
Paste | 4, Check program 1, 2091 Bytes
I Copy to device > 5. Check program 1, 2091 Bytes
Delete | &. Check program 1, 2091 Bytes
< Copy from device | 7. Check program 1, 2021 Bytes
8. Check program 1, 2091 Bytes
S | 9, Check program 1, 2091 Bytes
P — | Delete = | 10. Check program 1, 2091 Bytes
11, Check program 1, 2091 Byies
12, Check program 1, 2091 Bytes
Move down | 13, Check program 1, 2091 Bytes
14, Check program 1, 2091 Bytes
Import from file | 15, Check program 1, 2091 Bytes o
1 el e e 4 WU Db
Export to file | < > < >
Free Memory 16241 KB
| Close I

After successful transfer, the name of the test program is visible in the “Device” column.

Check program Manager *

The lists contain the check programs of the ChedkOpti project and of the device. You can transfer and manage the Chedk programs here,

CheckOpti: Device:

Mame Mame ~

part xyz new 30.07.18 /B, Smith , 5 KB I | 1. part xyz new 30.07,18 /B, Smith , 5KB |
|

MNew |
Copy | < Connect > T 2ol oyies
|

3. Check program 1, 2091 Bytes
| 4, Check program 1, 2091 Bytes

5. Check program 1, 2091 Bytes
£ Cherk nraoram 1 2091 Rutes

Pask
- Copy to device =

Close window.

Close Checkopti software and disconnect.

This means that all the data on the device and the system has been converted. It is recommended to carry out an
extensive test run.

If too many parts are still evaluated as "NOK", then the data basis with the existing images in Checkopti may be
too small. It is recommended to carry out the next step of the project optimization.
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Project optimization

Project optimization

Due to various influences during the implementation of the conversion, it is possible that the images in the data
storage may differ slightly from the current scanned images.
These differences cause the inspection result to be negative, especially for the "standard features" in the in-
spection program. This leads to an increasing number of so-called "pseudo rejects”. These parts marked as

"bad", increase the bad-part rate and thus the output of the system.
It becomes necessary to optimize the project.

he basis for this is the Project N. Connect Checkopti to the device as described above.

(The connection to the device should be established in the STOP state)

Arrange the "Parts list" and "Part contour" windows on the screen in such a way that you can view them both

With the icon "Record test parts” in part list window, the recording of the part images is activated

the system and record the parts.

. Then start

Part list - part xyz new 12.07.30 =N R = [=@]=]
s - & o E—
4% %6 % E 1] a0E) CCENMER e ——— L@
Sample parts, sorted by Test parts, soted by = ) FE- ) Q &.“ % e g =
[Acquistion sequence | [Acquistion sequence | ; ; : : : ~ [ Test part resuts
T 1.PatOni=1 L o] R e e e bl SRR bbb Ll AL Orientation 2
T 2 Pat Ori-2 e @ Deviation 70
T2 PetOni=1 3 =19 Orient. uncert 7
T 4 PatOni=2 — | @4 Parn 0= 2 ] A N S A S Tolerance E
T 5 PatOn=2 @5 Part =1 Record no. 2
05.04.2018 15172
Move |@E PatQri=2 Recorded on 05.04.2018 15:17:23
@7 Part =2 1200 Contour datasize 3078
8. Part Ori.= :
@2 FatOni= 1
@ 9. Pari Ori=2 Info__| Toal |_Featurs [
@10 Pat 0= 1 @1 ROl X coord. left
Delete | @ 11. Part 0= 2 1250 o2 ¥ coord. top
@ 12 Part Ori = 1 (Bad) @3 ¥ coord. rght
@13 Part 0= 2 4 Length x
@14 Pat =1 o &s Height y
@ 15. Pari Ori.= 2 (Bad) Qe Area
[ i.= 1 (Bad) 7 X coord. center of gravity 785 28 [Pixel]
@17 Pat =2 Y coord. canter of gravity 417.30 [Pixel]
@ 12. Part Ori= 1 (Bad) Inertia x £.162202+010
@19 Pat0i=2 Inetia y
@ 20. Part Ori= 1 (Bad) Circumference
Q@ 2 e /2
=1 (Bad) Areay/2
=2 {Bad) Pol. min. distance 9930 [Pixel]
2 Pol. max. distance 19 [Pivel]
1 . ROI1 frea 0 [Pueld
5 ROI 11 Area 0 [Pixslq
- 5 . CTool Height difference { Max. - .. 50.00 [Pocel]
@ 28 Part Ori= 1
@25 Part 0= 1 (Bad) v < = I 5
Good: 24 (61%) Bad: 15 (39%) Good but incorrect oriented %:1625 ¥:2086 Test part 2 Orientation 2 Information:

Each part is now displayed in the test part list. In the part contour window, the images appear with the respec-
tive result values of the individual test features.

Record approx. 200 parts. After that you can stop the recording.

The aim of optimizing, is to reduce the "pseudo-reject” rate. Therefore, you can now concentrate on the parts

marked with the red dot.

Select a part marked with red dot in the part list. This causes, this part to be displayed in the part contour win-

dow. E.g. part no. 16.
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Project optimization

Good: 24 (61%) Bad: 15 (33%)

Good but incorrect oriented

X:1639 Y:2035.

Test part 16

Qrientation 1 Information:

Part lst - part xyz new 12.07.30 (= | part xyz new 18.07.30 Bl ES
CENBOXE [ EE ShmER e L@
Sample parts, sorted by... Test parts, sorted by... BR X | o e ad@ & ® i )
[Acquisition ssquence ~| [2cquistion sequence ~| ; ; ; ; : ~ [Tost par resttts
_ i o ~ e L L e e e e EE TS Orientation 1
;l E:: 8: 1 Copy :1 o @ Devistion 12174 (Bad) <ffpm—
T 2 PatOn=1 Orient. uncert 6
Taratoi=2  —|[@2pPar0i=2 | 7m0l e b Telerance 5%
T 5. PatOn=2 < Record o i
P Recorded on 25042018 11:1026
Contourdatasize 3064
Info_| Tool [ Featurs [ 5] valus [
= @1. ROl X coord. left X 00.00 [Pocel]
Delete @11 Panoie2 || [12m0f-oceeooedeeb @2 ¥ coord. top Y 738.00 Pocel]
@3 X coord. right 1531.00 [Porel]
I @: Length x
1= Height y
D5 Area
B2 o centerof ooty
l 4 ¥ coord. center of gravity
LR Trets X T
410 Inettia y 3
on Circumference: 4
@1z Areax/2 2z
(Bad) @13 Areay/2 2
2d) Q12 Pol. min. distance 2
2 @15 Pol. max. distance 212,82 [Poeel]
P e A @15 RO Area 00.00 [Pixel]
2 @17. ROITT frea 1 [Pucel]
o2 dL1g. CTool Height differsmce | Max. - Mi 47.00 [Poxel]
1 w
@ 1(Bad) - B

Now evaluate the possible deviations in the image and for the features.

Then ask yourself the following questions?

Does the image correspond to a good part?
Is there a relevant change in the contour? e.g. caused by a poor feed.
Is the feature marked in red relevant for the position orientation or the quality of the part?
If yes, is the part still permissible or not?

If you come to the result that the displayed part corresponds to the specifications, then the part is copied into
the sample part list. This is done with the "Copy button" between the columns. (from right to left)

Part list - part xyz new 18.07.30 ][ (]
4; N& ’PI\EP > @ !/ l! 2
Sample é%rrls. sorted by... Test parts. sorted by...
|.£J:qu|smnn sequence j |.£J::quwsmon sequence -
T 1. PatOri=1 @1 PartOni=1 ~
T 2. Pat On=2 Cory @2 pan o2
T 2 Pat Ori=1 @ 3 P On= 1 (Bad)
T 4 Pat Ori=2
T 5. Pat Ori=2 Q
Move
Deele | @ 11 Far =2
@ 12 Part Ori = 1 Bad)
@13 Part Ori= 2
= @14 Part D=1
@15 rar 0
@17 Par 0
@ 12 Part Or = 1 (Bad)
@15 Part Ori = 2
@20 Part Ori = 1 {Bad)
@n
@
[ FE
@2
[ R
[ R
[
D
@ v
Good: 24 (61%) Bad: 15 (38%) Good but incorrect oriented

Due to a new additional sample part, the calculation and evaluation is carried out anew automatically.

The result shows that this part 16 has now been rated "good" (green dot). In addition, other parts are also rated

as "good" due to new limit values.
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Project optimization

Part lst - part xyz new 12.07.30 =N ECR < Part contour - part xyz new 18.07.30 =@ =]
P BE %@ A Bl G EMEY RS T RE(Z X
{70 | Sample pats. sorted by... Test paris, sorted by... BEX S oo | a S @S ®| s om0 B
o |[Acquisition sequence - |Acquistion sequence - : : : : : ~ [Test part resutts T T
T art Ori.= art Ori.= A Bl e e e TR LR FE LR e T T C L ETEECTS EEERT T} Orientation 1
12 T; EEQ g".:; Cony :; EE: g".:; el | @ Devition 57.20 (Good)
T 2 Pat 0= @3 Fat 0= 1(Bad) : Orient. uncert &
| Teraoi=2 @4 Pat Oz 2 ] KRS AN U I SO Tolerance 5
|| T Paroi-2 .5 FetOi-1 SEW: "; ;§D42D1E 11:10:26
Y il i | S
. SCAR | | O R SRR SO SN S
B :i :: g:;; nfo_[ Tool [ Featre (5] Value I
@10 Petrio1 @1 ROl X coord. left ¥ 00.00 [Pecsl]
: @11, Pat =2 ] et R bbby bbbl R bbbl Y coord. top Y 738.00 [Pixel]
@ 12 Petri- 1 Bsd) X coord. right 1531.00 [Pocel]
.13 Part Ori=2 Lengthx 1532.00 [Pixel)
@1aratoi=t 0 M lweseloeeo b Height y 455.00 [Poeel]
.15 Part Ori.= 2 (Bad) Ares 4 773662+005 [Pixelq
art Ori.= X coond. center of gravity 746.04 [Pixel]
: ¥ coord cemerafzmwty 462.27 [Pel]
@18 Ptcio1 Inertia x 8.303868+010
@19, Pat 0= 2 Inertia y 6.15400e+00%
@20 pet0i=1 Gireumfersnce 4524 00 [Pheel]
@21 Pat O 2 Areaw/2 253731e+005 [Fireld
@22 Pat Oii= 1 Areay/2 2.750932+005 [Pixel]
@2 Paioi-2 Pol. min. distance 214.44 [Pesl]
@24 Pt Orie 2 . Fol. max. distance £12.92 [Fire]
@25 Petcrio ! ! ' @15 ROIT Ares 00.00 [Pixsi]
@2 Ptci-2 ! : : : : @17 ROl res 12864.00 [Pirel]
@27 Pat Qri=2 : @12, CTool Height difference { Max. - Mi... 47.00 [Pixel]
@28 Patori=1 @ 250 500 750 1000 1250 1500 v
,25 Part Ori= 1 a 5 aQ o
Good: 30 (76%) | Bad: 9 (243 ¥i-34 ¥:2048 | Test part 16 Orientation 1 Information: | .4
This process is now repeated for the next remaining "red-marked" parts. In the course of these optimizations
more and more parts are evaluated as "good" and the output of the system is increased.
A Attention
Do not copy any wrong parts into the sample parts.
Examples of "Wrong" parts that should not be transferred to the sample parts: Collar too low!
7. X coord. center of gravity 78578 [Pixel]
--------------------------------------------- . coord. center ravi ¥ e
e ¥ coard of gravity £53 20 [Pixel]
@3 Inattia x 8.292122+010
(Rl Inettia y 5.91650=-009
- @11, Circumference 4572.00 [Pixel]
; @z freax/2 2.15645¢+005 [Pixeld
; @1z, freay/2 2.783022-005 [Pixel
________ e | @a Pol. min. distanca 210.33 [Pixel]
H H . 15. Pol. ma. distance 814 45 [Pixel]
1 1 @16 RO Area 128759.00 [Pix=ld
i i =011 s PR
. 250 =00 750 1000 1250 1500 V ‘ 18. CTool Height difference { Max. - Mi... 33.00 [Pixel] I
€ > € >
A1643 ¥i1103 |Te5t part 23 | Orientation 2 | Infarmation: | i
Wrong part type:
______ : N T e 7. ¥ coord. center of gravity 807.14 [Pixed]
. coord. center of gravity A b
e ¥ coord of 453 53 [Pixel]
4. Inrtia x 5.044385+010
& Inertia y §.07305=-003
1. Circumference 4740.00 [Piel]
; 4z Areax/2 2.32820e-005 [Pixel
1z Area y/2 2.882812+005 [Pixsld
________ (T Pal. min. distance 21562 [Fixel]
E E f 15. Pol. max. distance 834,54 [Pixel]
H H . a 1 s
@16 RO Are 12916.00 [Pixeld
: : @17 rROIM Lrea 00.00 [Picelq
. 280 £00 7ED 1000 1250 1500 - " 18. CToal Height difference { Max. - Mi... 259.00 [Poxel]
£ > £ >
X762 ¥:1386 Test part 33 | Orientation 2 Information: | ]
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Project optimization

[ # coord. center of gravity 754990 | P
f 8. Y coord. center of gravity 46561 [Pixel]
Os. Inertia x 236784010
&0 Inertia y 575472009
f 11. Circumference 4540.00 [Pocel]
' Dz, Area /2 2.17218e<005 [Pixelq
‘ 13 Area v/ 2 BE717e+005 [Puxe=lq
_E . 14. Pol. min. distance 208.72 [Piel]
1 \ 15 Pol. max. distance 815.72 [Pixel]
5 5 @15 RO Area 12787.00 [Pixeld
@17, ROIT Area 00.00 [Pixeld
. 250 £00 TEQ 1000 1250 1500 - ‘ 18 CTool Height differance { Max. - Mi... 38.00 [Pixel]
< > L4 >
K357 Y1416 |Test part 37 | Orientaticn 2 | Information: | v

Completion of optimization:

Since every change in Checkopti, e.g. moving tools, creates new limit values, the check program must be trans-
ferred to the checkbox again.

The new test program is transferred to the system as described in chapter 7.1.

Remember to name and save the new check program.
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Procedure for changed resolution

9 Procedure for changed resolution

A changed resolution produces "different" images of the part than before. This requires adjusting the position
and size of the tool.

This essentially concerns the offset values of the "center coordinates” of the tools. The easiest way to adjust the
tool is to move it by mouse. The size of the tool can also be easily changed with the mouse.

Example images with different resolutions:

Vertical: 512 Pix, Vertical: 512 Pix
Horizontal: Encoder to line-frequency ratio = 10 Horizontal: Encoder to line-frequency ratio =5
] S | S bemoe oo SRS .

O 250 O 50 200 750

The image of the part becomes "wider", the height remains the same.
The position of ROl is no longer correct. The offset value for "X coordinate center” must be adjusted to the posi-
tion of the notch. Move the mouse to the "correct" position. (Y-coordinates remain unchanged)

To make the adaptation of Project X, take the position of the ROl and move it to the point to be checked.
The size of the tool may also need to be adjusted. That depends on the inspection requirements.

Vertical: 2048 Pix, Vertical: 2048 Pix
Horizontal: Encoder to line-frequency ratio = 10 Horizontal: Encoder to line-frequency ratio = 5
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Procedure for changed resolution

The image becomes "higher" and, possibly, "wider". This increases the resolution in both directions.

The position of ROl is no longer correct. The offset value for "Y-coordinate center" must be adjusted to the posi-
tion of the notch. Move by mouse to the "correct” position. In the left example, the "X coordinate center" re-
mains unchanged. On the right, X and Y coordinates must be adjusted.

The size of the tool may also need to be adjusted. That depends on the inspection requirements.

The following comparison shows the relations, when using the changed resolution in X and Y direction:

=00 TEQ ] 250 500 750

On the left, with low resolution, the presence of an O-ring with approx. 300 pixels is checked. With increased
resolution in both directions and with adjustment of position and size, the ROl is checked with

approx. 2200 pixels.

This makes the evaluation more reliable and stable.

Adaptation of the project N with changed resolution

The basis remains the Project N. Basically, the aim is to exchange the images with low resolution for new images
with the increased resolution.

The procedure corresponds to the procedure described in chapter 8 of the optimization. You exchange the im-
ages with high resolution with the old images in the current file. This is managed in part list window as in figure
9.1.

Connect Checkopti to the device. Record at least 200 test pieces. Now the parts which correspond to the re-
quired image, position orientation and quality are copied from the test parts list into the sample parts list.

Images with low resolution must be deleted from the sample parts list! Only images of the higher resolution may
still be in this list (Select the Delete button or part and press "Del" on the keyboard.)

A Important

For a project with position orientation, make sure that the orientation assignment (Ori.1 or Ori.2) is
matching for the particular part. When copying the "bad parts", a wrong orientation could be as-
signed. The orientation can be assigned via the numbers 1-8 on the left edge of the sample parts
(the respective part must be marked).
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Procedure for changed resolution

Figure 9.1 Procedure in the partlist window:

Part st - Auflasung [ ] Partlit - Aufsung =0 el
CELEE XE L Ea CHRLBE XE| [ EE
@ Sample parts, sorted by. Test parts, sorted by @lSamp\e parts, sorted by... Test parts, sorted by...
o Acquisttion sequence ;I Acquistion sequence hd ori IAcqu\smnnsEquence - Acquisition sequence hd
—— =
1 = @1, Part Dri= 1 " AT 1 Part Ori=1 e @1 Pat 0= 2 (Bad) ~
5 # @z paton=2 Delete sample M | L2 PatOn-2 @2 ra0n=260)
s | |@2 paton=1 parts with o || @2 renon-2E0) Test parts with
® @2 Pai=2 il g — | @4 Pt 0= 2 (Bad) small resolution
4 © || @5 Pt 061 sma 4 © @5 Part =2 (B become “Bad” parts
5 Mave |6 PartOri=2 resolution . Vove | @6 Part Ori=2 (Bad)
@7 Pat On=1 @ 7. Pet 0= 2 Bad)
& 0= 8 > || 2. Par Ori= 2 {Bad)
7 S, Fart Ori.= 1 (Ead) 7 || Assign the correct . |[oTEoT
. @ 10. Part Ori= 1 (Bad) . orientation! @10 P 0= 2
@ 11, Part Ori= 1 (Bad) Delets | @11, Part Ori=1
@ 12 P O = 1 (Bad) . || @12 Panci=n ) )
= Ori= 1 (Bac) Copy parts with — @13 P 0=t Test parts with high
:14. Part Ori.= 1 (Bad) high resolution to > :14 Part Ori.= 2 resolution become
15. Part Ori = 1 (Bad) 15. Part Ori.= 1 "Good” part
sample part ood parts
@ 16.Pan Ori 1 (Bad) pep @16 P02
@ 17, Fart Ori= 1 (Bad) @17 Fat =1
@ 12 Par Ori = 1 (Bad) v @12 Par Oi=2 v
Good: 9 (37%) ‘ Bad: 15 (63%) Good but incomrect oriented: ﬂ i Good: 13 (39%) ‘ Bad: 9 (41%) |Goud butincerrect or\ented:d 4

Completion:

Every change in Checkopti, e.g. copying parts, creates new limit values, the check program must be transferred
to the checkbox again.
The new checkprogram is transferred to the system as described in chapter 8.

Remember to name and save the new check program.
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